what’s new in office 2013
your unofficial overview

by Christian Cawley
# Table Of Contents

1. Introduction 5  
1.1 Office 2013: What Have You Got? 5  
1.2 Upgrading and Backward Compatibility 5  
1.3 Microsoft Office 2013 on Windows RT Tablets 6  
1.4 Different Flavours of Office 2013 6  
1.5 Embracing the Cloud 6  

2. Office 2013 and the Metro UI 7  
2.1 Productivity for Fingers 7  
2.2 What Is Metro? 7  
2.3 Functional Changes Since Office 2010 8  

3. What You Need to Know about Word 2013 9  
3.1 Read Mode in Word 2013 9  
3.5 Improvements to Collaboration 11  
3.6 Define and Understand 11  

4.1 Recommended Charts 12  
4.2 Quick Analysis 12  
4.3 Suggested PivotTables 13  
4.4 Power View for Power Users 13  

5. PowerPoint 2013 – A New Dimension 14  
5.4 Improvements to Slide Design 15  
5.5 Collaboration Improvements in PowerPoint 2013 15  

6. Microsoft Outlook - Redesigned 16  
6.1 Inline Replies in Your Inbox 16  
6.2 Calendar Improvements 16  
6.3 People Are Contacts 17  
6.4 Don’t Touch It! 17  

7. The Secret Weapon: OneNote 18  
7.1 Making Notes the OneNote Way 18  
7.2 Embedding Spreadsheets 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.3 OneNote MX</td>
<td>19</td>
</tr>
<tr>
<td>8. <strong>Office 2013 and SkyDrive</strong></td>
<td>20</td>
</tr>
<tr>
<td>8.1 Integration with SkyDrive</td>
<td>20</td>
</tr>
<tr>
<td>9. <strong>The Rest of Microsoft Office</strong></td>
<td>22</td>
</tr>
<tr>
<td>9.1 Access</td>
<td>22</td>
</tr>
<tr>
<td>9.2 Publisher</td>
<td>22</td>
</tr>
<tr>
<td>9.3 Office 2013 Applications for Corporate Users</td>
<td>23</td>
</tr>
<tr>
<td><strong>10. Office 2013 – Should You Upgrade?</strong></td>
<td>24</td>
</tr>
<tr>
<td><strong>Appendix</strong></td>
<td>25</td>
</tr>
<tr>
<td>1. System Requirements</td>
<td>25</td>
</tr>
<tr>
<td>2. Installing Office 2013</td>
<td>25</td>
</tr>
<tr>
<td>3. Office Web Apps</td>
<td>25</td>
</tr>
</tbody>
</table>
1. Introduction

The world’s most popular productivity suite, Microsoft Office, is now in its seventh version with the release of Microsoft Office 2013, a cloud-integrated revision of the software that comes complete with the new tile-based user interface formerly known as Metro (the look of which you will be familiar with if you have seen or used Windows 8).

Microsoft Office 2013 comes with all of the usual component applications, most of which sport enticing new features. Compatibility with Windows is limited compared with previous Office versions, although this new incarnation does have touchscreen support for tablet computers and native SkyDrive cloud support for access-anywhere documents.

Most interestingly, Microsoft is offering several different flavours of Office 2013, most notably two subscription-based versions.

1.1 Office 2013: What Have You Got?

If you want to write reports and other documents, Microsoft Office 2013 is naturally equipped with the mother of all word processors, Word. Alongside this, the spreadsheet application Excel, presentation software PowerPoint and the popular note taking app OneNote are also included.

These four applications form the core of each version of Office 2013, while email and scheduling application Outlook, desktop publishing tool Publisher and database management software Access all remain available in Office 2013. InfoPath, Visio, Project and Lync can also be added to the subscription based Office 365 suites; you’ll find more about the different versions below.

1.2 Upgrading and Backward Compatibility

If you wish to upgrade your current version of Office to the new release, you will need to be aware that there is no “upgrade path” – you basically ensure your documents, dictionaries and templates are saved, uninstall the old version and install Office 2013.

Different versions are available, but you can head to http://office.microsoft.com to download the trial version of Office 365, which offers the best glimpse of the updated applications.

System requirements for Microsoft Office 2013 can be found in Appendix 1.

Sadly, Office 2013 is not compatible with Windows XP or Windows Vista. At the time of writing, XP commands over 40% of the market share of operating systems over 11 years after its launch; meanwhile Vista holds a modest 6%, so 46% of the market can’t upgrade without first upgrading their operating system.
1.3 Microsoft Office 2013 on Windows RT Tablets

As you may have gathered, there are several different versions of Microsoft Office 2013. The main version is for Windows computers, although there is an alternative version that comes included with Windows 8 RT devices.

If you have purchased a Windows 8 tablet running this particular version of the operating system (check the documentation to see if your tablet has an ARM processor or the phrase Windows RT is evident) features Office 2013 Home & Student RT for no extra cost.

Some features are downsized; to save space, for instance, templates, clip art and language packs must be downloaded, while older file formats, third party code for macros/VBA/ActiveX controls, PowerPoint narration, Excel data models and embedded media file search in OneNote have all been excluded.

The vast majority of things outlined in this manual apply to all versions of Microsoft Office 2013.

1.4 Different Flavours of Office 2013

In addition to the Windows 8 RT version of Office 2013, there are other packages available, suitable for different types of users and requirements.

Office 2013 Home & Student includes the core quartet of applications, as listed above, while Office 2013 Home & Business adds Outlook 2013. This guide will be most useful to anyone who has purchased either of these two versions.

In addition, a further package, Office 2013 Professional is available, which adds Publisher 2013 and Access 2013. There are also four versions of Office 365, Microsoft’s premium cloud-based office suite. Each of these has a different range of applications and different licensing packages.

Office 365 Home Premium offers support for five devices and includes Word, Excel, PowerPoint, OneNote, Outlook, Publisher and Access, with an optional Microsoft Project 2013 component and a viewer for Visio files. The other Office 365 suites add InfoPath and Lync 2013, as well as the following licensing options:

- **Office 365 Small Business Premium**: 10 maximum users, 5 devices per user.
- **Office 365 ProPlus**: 25 maximum users, 5 devices per user.
- **Office 365 Enterprise**: Unlimited number of maximum users, 5 devices per user.

1.5 Embracing the Cloud

It isn’t only Office 365 that makes use of the cloud, however. Whether you have purchased a single Office 2013 component or you’re running the full suite, integration with Microsoft SkyDrive is included.

Whether you’re running Office 2013 on Windows 8 (where SkyDrive is fully integrated with the OS), on Windows 7 (where SkyDrive has a downloadable component that adds it to My Computer), the suite can be easily connected to SkyDrive, enabling you to save documents to the cloud and open them later on in another location, or from another device.

You’ll find full details on this in Section 8, Office 2013 and SkyDrive.
2. Office 2013 and the Metro UI

As with any revised release of software, there are some changes to the appearance of Office 2013 that you might find a need a little getting used to.

Designed with the new Metro UI (which has since been renamed to “Modern” by Microsoft but continues to be referred to as “Metro” by technology journalists), Office 2013 is – like other applications and operating systems using Metro UI – designed to be easily used by finger tips.

Whether you’re using an on-screen keyboard on your Windows tablet device or pointing and clicking with a mouse in the traditional manner, however, you should experience little difference in the user experience.

2.1 Productivity for Fingers

Upon launching Office 2013, you’ll notice that things are a bit… square. This is thanks to the new user interface, and can be best summed up by the lack of rounded edges in favour of square tabs and windows.

Even the ribbon menu has been restyled – the rich-looking, rounded tabs replaced with something that aims to be far more functional.

In this area of the suite, there is very little difference to previous versions in terms of the arrangement and organization of features. If you can get past the Metro restyle, Office 2013 is a very familiar beast, a functional upgrade of the previous collection of applications.

2.2 What Is Metro?

First seen as the tile-based user interface and menu system on Windows Phone (released in 2010) the critical reaction to that mobile system’s UI was strong enough for Microsoft to roll it out to other services.

Xbox 360 consoles were first, followed by the webmail system Hotmail (restyled as Outlook.com) and then came Windows 8. Office 2013 is just the latest in a long line of Microsoft products being restyled for finger-focused interaction between human and computer, made possible with touch screen devices.
Of course, not everyone owns a touch screen device, so consequentially the Metro UI (now renamed by Microsoft as “Modern”, despite the continued use of the former term by technology journalists) can easily be interacted with by mouse and keyboard.

Anywhere you see tiles, square lines and the WP Segoe font you can be sure that the Metro UI is in use in some way.

### 2.3 Functional Changes Since Office 2010

Microsoft Office 2013 isn’t about the user interface of course – it’s about productivity. As with previous releases (that have also had UI revisions) Office 2013 features various functional changes, new features intended to make using the software better.

Various aspects of the suite have had revisions and improvements introduced in Office 2013. Collaboration and comments, for instance, is radically altered particularly in Word and PowerPoint. Elsewhere, the implementation of Metro UI and the various tablet-focused “touch modes” are worth investigating, if only for the varied success they each achieve.

Microsoft Access is arguably the recipient of the most notable revisions, optimised now for the creation of browser-based apps that can be deployed within corporate networks running SharePoint or Office 365.
3. What You Need to Know about Word 2013

Probably the most important element of Microsoft Office for the majority of users (and Microsoft!) is Word. The new version of the world’s favourite word processing tool is pleasingly familiar, despite the Metro trappings, and comes equipped with some excellent new features and revisions of older features that further confirm its place in the hearts of businesses, colleges and home users everywhere.

In addition to upgraded features and functions, Word 2013 includes various new features, such as a read mode and the ability to edit and review PDFs.

3.1 Read Mode in Word 2013

Available by opening View > Read Mode, this new feature is designed to enable you to get a full page view of the document that is unsullied by menus or other formatting tools. It might be considered to be particularly suited to tablet devices, but if your monitor is capable of displaying a desktop rotated vertically, you'll also see some benefit.

In addition to Read Mode, the full screen view has been rescued from the hidden menus (or its place on the Quick Launch toolbar for many users) and given a new home in the upper-right corner of the Word 2013 window. This is arguably not as good as the tool in previous versions, however, and forgoes text-only, button-free purity in favour of left and right panes for any tools that are active.

3.2 Finding New Templates

One of the most important things that the hardcore Microsoft Word user should understand is the creation and management of templates. Word 2013 has a new screen for creating templates, accessed when you first launch the application.
This “backstage” area is like an amalgamation of the Word 2010 File menu and the New screen, presenting links to Recent documents on the left and a selection of new templates on the right.

Here you’ll find a good selection of new and improved templates, covering everything from blog posts and Thanksgiving invitations to annual reports and live music flyers. Naturally these can all be edited as before to produce work tailored to your own needs, and a search tool at the top of the page provides access to templates online. Where appropriate, search will display suitable templates for other applications in the suite.

### 3.3 Advanced Document Layout

Justification, indentations and text wrapping all continue to be present in Word 2013, but the way in which images or other embedded element can be placed has been improved thanks to the live layout system. This feature allows you to left-click the image before dragging it around the page, placing it exactly where you want.

![Image of layout options]

Text can be set to flow around, behind or in front as before, but it is with the fluid positioning of elements that this feature really stands out. Changes to wrapping can be made by the contextual pop-up icon that is displayed (see image).

While we’re talking about embedding media, online images and videos can finally be embedded into a Word document in Office 2013, via the Insert tab.

### 3.4 Editing and reviewing PDFs

While Microsoft spent so long pushing its own document imaging system, Adobe’s PDF grew into the de facto standard. As a result, versions of Microsoft Office have been slow to adopt the file type. Even Office 2007 was released...
without the ability to read and create PDFs until the release of Service Pack 2.

Word 2013 builds on this by providing support for creating and editing PDFs. Note that editing PDFs can be hit and miss – the process requires that the existing PDF document is converted into DOCX format, something that can result in an inaccurate layout. Simple layouts should convert without too much trouble, however.

Note that editing takes place once the file is converted to DOCX format, and as such you will need to select the PDF file option in the **Save as** dialogue box to keep your changes.

### 3.5 Improvements to Collaboration

If you regularly work on documents with others, then the improvements to Microsoft Word’s collaboration and review tools might prove interesting.

This revision enables much easier collaboration by including a simplified mark-up view and support for cloud drives.

Both of these features enable a streamlined commenting system, resulting in real time feedback and discussion within the body of the document!

Handling comments is so much easier. Say you’ve been sent a document to review; you can add a comment by highlighting the passage and clicking **Insert > New Comment** from the ribbon. Your thoughts can then be entered into the box with your name and picture displayed, and subsequent comments will appear threaded. Meanwhile tablet users can make comments using a stylus, while the previously slow task of comment removal in a finished draft is easily done by checking off each one in turn.

### 3.6 Define and Understand

Also on the Review tab you will find a new tool to help with language and grammar. The Define function is launched by selecting the word or passage and then clicking the button in the Proofing section of the ribbon menu or by pressing CTRL+F7 and is used in conjunction with built in tools or plugins to gain extra understanding of a word or reference.

On first use of this feature, you may be prompted to download a dictionary. Among those available is the Merriam-Webster dictionary.
4. Does Microsoft Excel Do Enough Already?

Did you know that the basis for the first complete electronic spreadsheet software (VisiCalc) was inspired by a blackboard-based calculation? Or that Microsoft Office owes its existence to this application?

Microsoft Excel has come a long way since its initial release on early Apple computers as a competitor to VisiCalc, but remains eminently flexible. It’s in use variously as a time management tool, database, statistical analysis software and much more. In fact, it’s surprising that Microsoft can continue to add features to what is essentially a counting program.

However, in the face of threats from hardcore data analysis tools, Microsoft does make improvements to Excel that maintains the application’s multi-purpose versatility. Excel 2013 includes several upgraded functions and features.

4.1 Recommended Charts

Following the chart presentation improvements of Excel 2007 and 2010, the new version does away with the focus on the chart wizard, instead offering the Recommended Charts tool. The way in which this works is pretty intuitive; a table with a simple layout of two rows and four columns will result in a suggestion of a simple chart such as a line bar.

Meanwhile a more complicated table will result in the suggestion of a more detailed chart, and the beauty of this new recommendation system is that you can choose a different chart if you don’t like the results.

When entering a table, the **Recommended Charts** button can be found on the **Insert** tab. Remember to select the table before click the button. If your table features a lot of different data types, these can be hidden if necessary using the Filter button displayed to the right of the chart in Chart Design view. This Chart Filters option streamlines the process of adding and removing data from a chart with simple check boxes and also enables the switching of the chart design between 2D and 3D.

You can also get some good reactions from anyone viewing your chart by changing a value in your chart’s table – the chart’s adaptation to the new figures will be animated, always great for the “wow” factor.

(Note that online collaboration still isn’t possible for Excel – look out for the memorable “File is locked” warning when you try to edit an already open file.)

4.2 Quick Analysis

Introduced in Excel 2007, conditional formatting enables the user to apply formatting based on the contents of the cell (a prime example might be colouring the text red to represent a loss).
In Excel 2013, conditional formatting has been made easier to apply, thanks to the Quick Analysis icon that appears at the bottom right of a selected table or portion of data. This enables you to quickly select from a common selection of conditional formatting (such as the example above). With this tool you can also quickly display sum figures, calculate averages and count values in your table.

4.3 Suggested PivotTables

There was a time when to be a master of Excel you had to understand PivotTables inside-out. With Excel 2013 there is still a requirement to be familiar with this feature, but a new tool, Suggested PivotTables, enables casual users to take advantage of the software’s ability to handle interconnected data.

Like Suggested Charts, this feature is easy to use. Once you’ve selected your data, use the Insert tab to find the Suggested PivotTables button and observe the results.

4.4 Power View for Power Users

Unavailable in the smaller packages is Power View, which comes as part of the Office Professional Plus version of Excel. This tool is Excel’s key weapon in the battle against various business intelligence packages, and can turn a huge table of numbers into striking, meaningful graphics (for instance, complex information with reference to locations – perhaps sales data – can be displayed by making use of Bing Maps).

The addition of the PowerPivot add-in turns Excel into an application that can potentially rival successful business intelligence software such as Business Objects.
5. PowerPoint 2013 – A New Dimension

Every day, in offices across the world, people are struggling to stay awake in presentations.

This is rarely the fault of the software, and almost always due to the unimaginative content and the ability (or lack of!) of the speaker. Making presentations more compelling is a challenge that Microsoft sets itself with each new release of PowerPoint.

Over the years this has been attempted with the addition of embedded rich media and improved performance, and this time around Microsoft have delivered improvements to slide design, new swipes and zooms and even a new view.

5.1 Don’t Edit With Fingers!

One of the things that you will need to bear in mind with Office 2013 is that although the new Metro-style user interface is intended for use by fingers, it isn’t perfect for this use.

This is typified in PowerPoint 2013, where you should be very careful about using anything other than the traditional mouse and keyboard to create and edit new presentations. Elements such as the window controls in the top-right, the zoom slider at the bottom and even the touch mode switch are clunky and difficult to access with fingers.

If your tablet has a stylus, then use this, but certainly don’t rely on your fingers!

5.2 New Look Presenter View

Thanks to the Metro look for PowerPoint, Presenter View has a brand new look. Aimed at users who will be displaying their presentations via a projector or large display, it offers a different view to the one being displayed. The Presenter View enables the user to plan ahead by displaying notes about the slide and providing a preview of the next, and offers various other controls, including a pen tool for drawing the audience’s attention to a particular slide or detail.

A new Navigation grid in Presenter View enables you to...
easily navigate between slides, while Slide Zoom allows you to zoom into a slide either with the finger-thumb “pinch” gesture or by clicking the mouse.

5.3 Swipes and Zooms in Presentations

Zooming and swiping is common in PowerPoint 2013. For instance, there is a new dialogue box that sweeps in from the right-hand side of the screen, although curiously this isn’t a design element that is carried across Office 2013.

Although the use of fingers for editing presentations is not advised (see above), viewing a PowerPoint presentation on a touch screen tablet brings a whole new dimension to the finished product, enabling you to swipe left and right to navigate through the presentation, pinch or tap to zoom and overall enabling you to focus on the presentation.

The possibilities of impressing your audience by delivering a PowerPoint presentation through a handheld touch screen device are evident!

5.4 Improvements to Slide Design

Although there isn’t anything considerably different in PowerPoint 2013, Microsoft has nevertheless introduced a few useful tools to improve the experience of creating a new presentation.

If you’re using a modern laptop or a tablet, the chances are that it is a widescreen device. New templates in 16:9 format have been added to the application and to Office.com, and the task of modifying slides has been streamlined too. Themes included in PowerPoint 2013 come with several variants, enabling you to change the colour of backgrounds, headings and other elements. You can think of these alterations as “sub-themes” and they add a new dimension to creating new presentations.

Elsewhere, Pictures, text boxes and other elements can be easily aligned and arranged on a slide by dragging them into place, and colour matching is made easier with the addition of an eye dropper tool.

You will have seen in the section about Microsoft Word 2013 that support for embedding online content has been added and the same is true in PowerPoint 2013, with embedding available on the Insert tab.

5.5 Collaboration Improvements in PowerPoint 2013

Along with the focus on the cloud (as explained earlier and in more detail in Chapter 8), PowerPoint 2013 boasts the same collaboration enhancements as Word.

Presented in a very similar manner, the upgraded comments are indicated by a small speech bubble, with a provision for inline replies. If you’re using PowerPoint 2013 in a corporate setting and have Lync installed, the Presence system will let you know if collaborators are available to chat. Unlike Excel, PowerPoint enables multiple users to work on the same presentation at the same time with SkyDrive, a corporate network and PowerPoint Web App as the source location.

The excellent Present Online tool has also undergone a revision; this makes it possible to webcast slideshows, and you can manage these via the Presenter View.
6. Microsoft Outlook - Redesigned

While its application in Windows Phone and Windows 8 is stunning, Metro is a reasonably good user interface in most cases. Unfortunately for Outlook 2013, the new look doesn’t quite work.

This is most evident when viewing the emails list pane, where distinction between the displayed messages is less-than-clear.

Functionally, meanwhile, Outlook 2013 features a few overdue enhancements, such as inline replies in emails and the much-vaunted integration with Microsoft’s recent acquisition, Skype. Unfortunately, touch interface options prove difficult with Outlook 2013 on a tablet/touch screen device, which is disappointing given how easily the same bunch of features are accessed on a Windows Phone.

While the icons in the lower left corner have been replaced with Metro-esque buttons for Mail, Calendar, People and Tasks, the rest of the interface is limited to the theme chosen when you initially setup Office 2013.

6.1 Inline Replies in Your Inbox

Traditionally, in Outlook, replies could only be written in a new window, activated when the Reply button was clicked. With Outlook 2013 this has been revised (at last!) to enable emails to be replied to within the Reading Pane.

This saves some time, as do the majority of improvements in the email view. Many people opt to delete messages once read, and this has been made much simpler in Outlook 2013 with the provision of a contextual **Delete** button that appears when the mouse is hovering over a message.

Revisions to the new mail notifications (in Windows 8, this is integrated with the operating system’s own notification system) result in less information, and no option to delete messages.

6.2 Calendar Improvements

The useful calendar preview displayed in the Outlook 2010 inbox view remains in Outlook 2013, while the **Calendar** label now displays forthcoming appointments when the mouse is hovered over it.
On the whole, however, little has changed in the calendar itself, which takes most of its update queues from Outlook.com. As a result, weather icons appear along a strip beneath the ribbon menu while the current time of day is indicated by a coloured strip across the Daily and Weekly views.

### 6.3 People Are Contacts

Another Windows 8 influence is the renaming of the Outlook contacts list to People. In Outlook 2013 it duplicates the operating system app, unifying contacts from LinkedIn, Facebook and Windows Live, and enables the additional unification of duplicates into a single card.

Additionally, favourites from your People list can be added to the to-do bar on the right-hand of the Outlook window (along with the calendar preview) which is useful for checking their status or whereabouts.

### 6.4 Don’t Touch It!

Like PowerPoint, Outlook 2013 features a so-called touch mode, but this is disappointing. To begin with, the small drop-down menu used to start touch mode requires the use of a mouse to access it!

Once activated, Outlook’s touch mode is little more than a simplified version of the main app, with the addition of a white border around various elements and some shortcut buttons along the side of the screen.

All in all, as touch-friendly apps go, Outlook 2013 isn’t even close. Various touch gestures – such as Calendar view’s pinch-to-zoom, which switches between day, week and month – work well, but Outlook’s functionality is left wanting in touch mode.

If using Office 2013 on a Windows 8 tablet you might be better off relying on the native Mail, Calendar and People apps…
7. The Secret Weapon: OneNote

Arguably the most underrated application in the Microsoft Office suite, OneNote 2013 features some useful enhancements including an alternative version for tablets.

If you’re not using OneNote already you really should consider it. Microsoft has released versions of this cloud-synced note taking app for all popular mobile platforms, and its flexibility is such that if you haven’t tried it already you’ll probably keep going back to it once you do!

7.1 Making Notes the OneNote Way

First introduced in Office 2003, OneNote has evolved carefully over the years, reaching its current state of SkyDrive-reliant syncing notebook that can be accessed from Windows Phones (and other mobile devices).

In OneNote 2013 there has been a slight reorganization of key tools but little to indicate a wholesale rethink of the application.

Making notes is easy thanks to the large notebook portion of the screen, while navigation through notebooks can be performed via a new dropdown menu that appears via an arrow below the notebook title.
7.2 Embedding Spreadsheets

Probably the most notable addition to OneNote comes with the improved spreadsheet tool, which enables you to create Excel tables within notebook pages. This is long-awaited improvement on the previous tablet tool, and existing Excel documents can be embedded and edited, another overdue improvement.

It’s not just Excel that can be found embedded in OneNote – Visio diagrams can also appear in your notes, with real-time, instant edits available, simply by double-clicking the embedded diagram, launching the main application and saving.

7.3 OneNote MX

Touch in OneNote 2013 comes in two flavours. For standard use, the tiny Quick Access Toolbar again provides access to the Touch Mode button, and as with Outlook 2013 the implantation is of the slapdash, enlargement and spacing out variety.

However, OneNote 2013 sports a bit of a surprise in the shape of a separate app called OneNote MX. This is very much a touch-based application, featuring a circular menu system that wields formatting controls. A single tap of the word or phrase that requires editing displays an on-screen button that results in the menu, which cleverly offers access to a wide selection of controls in a limited space.

OneNote MX also features a useful method of navigating through notebooks, sections and pages by dragging them out in panels from the left side of the screen.

As good as this seems, OneNote MX isn’t perfect. Sure, it’s a step in the right direction, and you’ll be hard-pressed to use your fingers to format text in the standard OneNote with such efficiency, but sadly there are a few key aspects missing from this version, such as the ability to record audio notes and the useful text-in-photos recognition tool.
8. Office 2013 and SkyDrive

Another key aspect of Office 2013 that is considerably different from previous versions of the productivity suite is the integration with SkyDrive, Microsoft's cloud storage system.

More and more services have been incorporated into SkyDrive over the past few months, from Windows 8 profiles to documents created in Microsoft Office Web Apps, so it should come as no surprise to learn that SkyDrive is a storage option when you create and save files.

In fact, SkyDrive is the default storage choice, whether you have an online Windows account or not.

8.1 Integration with SkyDrive

Office 2013, like the new Windows, features close integration with Microsoft’s free cloud storage service SkyDrive. It’s that close that you always know when you’re signed in, and although an advantage for many, you might prefer not to have your documents automatically saved to the cloud.

There are two ways to sign into Office 2013, via a Microsoft account (such as Hotmail, Windows Live or even Xbox Live) or using a network account for a school or business. Only the former will provide access to SkyDrive, however (the latter providing access to local cloud storage, perhaps through SharePoint).

In any of the Office apps, switching to the File tab and opening Accounts displays the various services and accounts associated with your profile. If you’re using Windows 8 these might be plentiful. You may notice a Remove option –
note that this can only be used if there is another user account setup on the PC in question.

However, you can prevent SkyDrive from being the default save location. This is easily configured via File > Options > Save, where the check against Always show “Sign in to SkyDrive location” during Save should be cleared.
9. The Rest of Microsoft Office

Depending on which version of Microsoft Office you purchase, you’ll also be able to gain access to the more advanced tools, such as Access, InfoPath, Lync, Project and Visio.

These tools are included in the more expensive collections, and are aimed at small and medium sized businesses that require databases, instant messaging, project management, diagramming and electronic form design.

They’re not aimed at students (although Microsoft Access might prove useful to many) and as a result we’re only going to cover the key updates introduced to each package in Microsoft Office 2013.

9.1 Access

Microsoft’s popular desktop database management application Access is used for tasks as diverse as payroll to running websites. This new version adds some interesting new features along with the new look Metro interface.

Browser-based database apps can be built and deployed through Office 365 or a corporate SharePoint server, with the option to add predesigned table templates. Data can be imported from other sources for these apps, which can be easily launched/deployed from the File menu.

9.2 Publisher

If the features of Microsoft Word aren’t enough to enable you to produce the type of documents that you want, Microsoft Publisher 2013 may be able to help.

As a desktop publishing application, Publisher is aimed at small businesses without the funds for a design specialist or a copy of QuarkXPress. The lack of compatibility with this and Adobe InDesign continue to make Publisher one of Microsoft’s few niche products; the PUB format cannot be opened in other Microsoft applications or other office suites, for instance.
Limitations aside, Publisher has been widely used in small business offices and the latest version adds some new features and a new look. Along with the expected Metro-fication of the user interface, additional effects such as shadows, glows, and reflections can be added to text, pictures and shapes, with new preset styles that can be set with a single click. Again, images from the web can be added, and images can be set as page backgrounds.

There’s a feeling with Publisher that you might be able to achieve so much more than with earlier versions – but of course, this will depend on your imagination…

9.3 Office 2013 Applications for Corporate Users

In addition to the standard applications that ship with the basic versions of Microsoft Office 2013, there are additional components, such as InfoPath, Lync, Project and Visio.

Rules and conditional formatting are among the new features in InfoPath 2013, along with support for a wide variety of database formats.

The latest version of the corporate online messenger Microsoft Lync features a selection of improvements to its collaboration tools, using whiteboard documents and PowerPoint presentations. Desktop and application sharing is also possible through Lync.

Microsoft has avoided any major revisions to Project 2013 other than the Metro UI and the addition of Project Portfolio Management, a flexible, online tool that can be used to manage projects “live” from a number of devices rather than relying on the more static, tradition interface.

Finally we have Microsoft Visio 2013. With easier creation of diagrams, improved simultaneous collaboration and touch support, Visio 2013 enables the linking of diagram shapes to real-time data, unleashing the power of the application as another statistical tool. Diagrams can be shared through the browser with Office 365 and SharePoint, and the tool supports the latest diagramming standards.
10. Office 2013 – Should You Upgrade?

By now you should have an idea of how to access the most important new functions added to the Microsoft Office suite, have come to grips with the Metro user interface and gained some understanding of the use of SkyDrive as a cloud storage system in Office 2013.

The big question, of course, is whether you should be prepared to part with your hard earned cash for the suite (or even individual components).

Well, let’s consider the facts. First and foremost, this is the first version of Microsoft Office to offer a cloud-based subscription version to standard users in the shape of Office 365. Sadly, it is also incompatible with Windows XP and Windows Vista. This means that only users running Windows 7 and Windows 8 computers will be able to take advantage of the new features.

Meanwhile, if you’re not a fan of the Metro UI then you’re probably going to be frustrated by Office 2013.

All in all, this is a good upgrade to Microsoft Office that ticks all of the right boxes but doesn’t really offer much in the way of new “killer” features that might compel you to upgrade.

As with any software purchase, the final decision is up to you. If you feel that there are enough new features to justify an upgrade and you’re running Windows 7 or Windows 8 then Office 2013 should suit you. However, if you’re happier with Windows XP and don’t need SkyDrive integration then previous versions of Microsoft Office or a completely different suite might be your preference.
## Appendix

### 1. System Requirements

Each version of Microsoft Office requires a system with a higher minimum system specification, and Office 2013 is no different. System requirements for Microsoft Office 2013 are as follows.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz or greater x86/x64 Processor with SSE2 instruction set</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB RAM (32 Bit), 2GB RAM (64 Bit)</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>3.0 GB free disk space</td>
</tr>
<tr>
<td>Display</td>
<td>1024 x 576 resolution or higher</td>
</tr>
</tbody>
</table>

Meanwhile, graphics hardware acceleration requires a DirectX10 compatible graphics card, and Microsoft Office 2013 will run on Windows 7, Windows 8, Windows Server 2008 R2 and Windows Server 2012.

Processor aside, the release of Microsoft Office for Windows RT devices (such as the Surface RT) has the same system specs.

### 2. Installing Office 2013

If you’ve purchased a standard disc copy of Microsoft Office 2013, installation will be straightforward, directly from the optical media.

On the other hand, if you’ve signed up to Office 365, installation will be via a download from the web. One advantage of this is that you will be able to start using some of the apps before installation has completed – useful if you’re in a rush! Full details – and a free trial – can be found at [http://www.microsoft.com/en-us/office365/](http://www.microsoft.com/en-us/office365/), where you will also find information about the subscription options for Office 365, which start at $6 a month.

### 3. Office Web Apps

Like the desktop version of Microsoft Office 2013, the Office Web Apps have been restyled with the Metro UI.

Microsoft Office Web Apps can be accessed through most browsers; simply sign into a Windows Live/Hotmail account at [https://skydrive.live.com/](https://skydrive.live.com/) in order to start using the online versions of Word, Excel, OneNote or PowerPoint.

While the features on offer aren’t as comprehensive as those in the desktop apps, these web tools nevertheless offer a considerable advantage to anyone planning to run a home or small office on a tight budget – they’re absolutely free to use! Documents created and edited with Office Web Apps are automatically stored to SkyDrive.
Did you like this PDF Guide? Then why not visit MakeUseOf.com for daily posts on cool websites, free software and internet tips?

If you want more great guides like this, why not subscribe to MakeUseOf and receive instant access to 50+ PDF Guides like this one covering wide range of topics. Moreover, you will be able to download free Cheat Sheets, Free Giveaways and other cool things.

Home: http://www.makeuseof.com
MakeUseOf Directory: http://www.makeuseof.com/dir
MakeUseOf Answers: http://www.makeuseof.com/answers
Geeky Fun: http://www.makeuseof.com/tech-fun
PDF Guides: http://www.makeuseof.com/pages/
Tech Deals: http://www.makeuseof.com/pages/hot-tech-deals

Follow MakeUseOf:

RSS Feed: http://feedproxy.google.com/Makeuseof
Newsletter: http://www.makeuseof.com/join
Facebook: http://www.facebook.com/makeuseof
Twitter: http://www.twitter.com/Makeuseof

Think you’ve got what it takes to write a manual for MakeUseOf.com? We’re always willing to hear a pitch! Send your ideas to justinpot@makeuseof.com; you might earn up to $400.